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ABSTRACT 
This report details the use of geospatial analyses as a tool for analysis during consultation under 
Section 7 of the federal Endangered Species Act. This example can be used as guidance for 
future analyses that support Section 7 consultations. Currently, consultations, formal 
consultations with a biological opinion, do not always include intensive Geographic Information 
System (GIS) analyses. They use project details provided by the action agency and project 
applicant, best available data, population models, population models, and literature reviews to 
understand potential effects. More consultations could be complemented by GIS analyses. The 
increasing availability of GIS software and easy-to-use functions provides more ability to 
quantify and understand impacts. The purpose of this report is to detail the basic functions and 
tools used within ESRI’s ArcGIS software to provide an environmental impact assessment. This 
report will focus on examples of GIS analyses from consultations for New Jersey Wind Port and 
Edgemoor Terminal located in the Delaware River. 

 

Disclaimers 

The views and opinions expressed are those of the author and do not reflect the official policy or 
position of any agency of the U.S. government. The results presented here are only examples and 
do not necessarily represent the final analyses of the biological opinions. This report does not 
depict official agency opinions or values associated with the consultation. 
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CHAPTER 1  
1.1 Introduction 
As geospatial technologies improve, opportunities increase for using these technologies to 
inform planning processes. One of these processes is consultation under Section 7 of the 
Endangered Species Act (ESA) which requires federal agencies, such as the Army Corps of 
Engineers (USACE), to consult with NOAA Fisheries to ensure that their actions are not likely to 
jeopardize the continued existence of ESA-listed species under NOAA Fisheries’ jurisdiction or 
destroy or adversely modify these species’ designated critical habitat. If an action may affect but 
is not likely to adversely affect, an informal consultation is conducted. If an action is likely to 
adversely affect ESA-listed species and/or their designated critical habitat, the federal agency 
must request formal consultation with NOAA Fisheries. In a formal consultation, NOAA 
Fisheries prepares a biological opinion that documents its opinion, and the basis for it, on 
whether the federal action is likely to jeopardize the species or adversely modify critical habitat. 
Geographical analyses can provide valuable information to inform the determination reached in 
the consultation. 
 
NOAA Fisheries regularly consults with the USACE on activities in rivers and estuaries that 
include dredging of bottom substrate. For instance, construction of new ports commonly requires 
dredging to develop berths and access channels and existing waterway infrastructure require 
frequent dredging to maintain sufficient depth for vessel traffic. Dredging to construct and 
maintain berths, navigation channels, and anchorages can remove or reduce habitat supporting 
essential behaviors of ESA-listed species such as foraging and spawning. The propeller jet of 
vessels using these waterways can also impact these habitats by scouring the bottom substrate, 
causing chronic disturbance to the riverbed, and elevating suspended sediment levels. Habitat 
impacts, additional vessel traffic, and turbidity plumes are all consequences of constructing new 
ports and terminals that can affect the Delaware River populations of endangered Atlantic 
sturgeon and shortnose sturgeon, as well as Atlantic sturgeon critical habitat within the Delaware 
River. By utilizing existing data and GIS layers, we are able to quantify impacts to the riverbed 
that will result from construction of proposed terminals and ports. This information can be used 
to support the analysis of how removal and/or degradation of channel bottom habitat will 
indirectly affect listed species and their designated critical habitat. Geographical analyses can 
provide a valuable tool to analyze the geographic extent of habitat effects for a single dredging 
project as well as the aggregate effects of multiple projects. 
 
Here, we use two recently completed formal consultations with the USACE on their proposed 
authorization on the development of two new ports in the Delaware River as examples of how 
GIS can support in evaluating the effects of dredging on shortnose sturgeon and Atlantic 
sturgeon critical habitat. The location of these two ports overlap with the distribution of 
shortnose and Atlantic sturgeon and Atlantic sturgeon critical habitat. Shortnose sturgeon were 
listed as endangered in 1967 (32 FR 4001), and the species remained listed as endangered with 
the enactment of the ESA in 1973. In 2012, NOAA Fisheries listed five distinct population 
segments (DPS)1 of Atlantic sturgeon as endangered or threatened under the ESA. The Delaware 
                                                            
1Under the ESA, a distinct population segment—or DPS—is a vertebrate population or group of populations that is 
discrete from other populations of the species and significant in relation to the entire species. The ESA provides for 
listing species, subspecies, or distinct population segments of vertebrate species 
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River is part of the endangered “New York Bight” DPS (77 FR 5879, February 6, 2012). Further, 
in 2016, NOAA Fisheries designated critical habitat for each Atlantic sturgeon DPS. The 
Delaware River critical habitat unit for the Atlantic sturgeon New York Bight DPS includes the 
river from its mouth with the Delaware Bay to Trenton, New Jersey (82 FR 39160, August 17, 
2017). 
 
We present our findings on using GIS analyses to summarize, compare, quantify, and visualize 
some of the impacts for the Section 7 consultation on the development of the ports and explore 
its use as a potential future opportunity for this future consultations. We include lessons learned 
in terms of how incorporating geographical analyses can improve the process, including 
understanding overlaps, minimizing conflicts, may assist in quantifying impacts, and increasing 
transparency for stakeholders within the federal process. Incorporating spatial knowledge allows 
us to better understand the socio-ecological interactions within the consultation context.
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1.2 Scope of GIS Analysis 
GIS software was used to develop spatial information and graphics to analyze effects from 
habitat modifications in the Delaware River for support of the development of two biological 
opinions. Both projects are located in the lower Delaware River and are new port developments. 
The first project, the New Jersey Wind Terminal (NJWP), is located at Artificial Island, New 
Jersey, close to the river’s mouth at Delaware Bay. The second project, the Edgemoor Terminal, 
is located approximately 21 miles upstream of the NJWP. Both projects include the dredging of 
previously undredged areas to construct berths and access channels for the ports. 
 

 
Figure 1-1. Proposed project areas with navigation channel and river mile markers. 

A biological opinion includes a project description that has information necessary to analyze 
effects to listed species, a baseline section providing information on existing conditions, and an 
effects section analyzing the effects the proposed activities and their stressors may have on listed 
species. This analysis focuses on the action area; defined as “all areas to be affected directly or 
indirectly by the federal action and not merely the immediate area involved in the action” (50 
CFR§402.02). We used GIS to calculate the acreage of dredging, the action area, and the 
baseline habitat features impacted using existing and created GIS layers. This was then used to 
assist in calculating the proposed projects’ impacts to critical habitat for Atlantic sturgeon. 
For these two consultations, the action area considered for the GIS analysis includes the reach 
just upstream of the project sites to the mouth of Delaware Bay, we included in the scope of the 
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GIS project the full reach of the lower River from the downstream end of Little Tinicum Island, 
Pennsylvania, to its mouth with the Delaware Bay. This reach represents the transition from 
freshwater to increasingly higher salinity at the river’s mouth caused by tidal intrusion of marine 
waters from the Delaware Bay. By utilizing existing data and GIS layers, we were able to 
spatially analyze some of the impacts of the proposed NJWP and Edgemoor Terminal 
construction on designated critical habitat of Atlantic sturgeon. 

 Atlantic Sturgeon 
Atlantic sturgeon are a diadromous fish. Diadromous fish species travel between saltwater and 
freshwater on a regular basis, and their capacity to adapt to diverse salinity environments varies 
during their lives (Shrimpton 2012). As Atlantic sturgeon mature to adulthood, they migrate 
along diverse saline environments to the marine environment (i.e., downriver). When larvae 
hatch in freshwater, they hide on the bottom and move downstream until they reach rearing areas 
in the freshwater reach just above the saltwater front in the estuary. As juveniles, they remain for 
one to five years in the river before migrating into nearshore coastal waters as sub-adults. These 
young Atlantic sturgeon move considerably once they leave their natal rivers. Because sub-adults 
leave their birthplace rivers to travel along the coast, sub-adult aggregations within a river may 
contain fish from two or more separate natal populations (Jones 2006). As adults, they return to 
the rivers to spawn. In rivers from Delaware to Canada, adults spawn in the spring and early 
summer. The lower tidal Delaware River is an important aggregation and foraging area for 
sturgeon as they develop from eggs and larvae into adults. Atlantic sturgeon are bottom feeders, 
feeding on invertebrates including crustaceans, worms, and mollusks, as well as other bottom-
dwelling fish. All life stages of Atlantic sturgeon require adequate amounts of quality habitat to 
support development. 
 
The habitat of Atlantic sturgeon can be disrupted, deteriorated, or destroyed as a result of human 
activities. For effective spawning, sturgeon require firm bottom substrates (e.g. cobbles and 
rocks) in freshwater reaches with appropriate water flow and dissolved oxygen; therefore, any 
action that alters such habitat can directly (e.g., dredging) or indirectly (e.g., sedimentation, 
increased vessel traffic) impact Atlantic sturgeon habitat. All life stages of Atlantic sturgeon 
require adequate amounts of quality habitat to support development and survival. 

 Critical Habitat 
When a species is listed under the ESA, NOAA Fisheries is required to determine whether there 
are areas that meet the definition of critical habitat. Critical habitat is defined as specific areas 
within the geographical area occupied by species, at the time of listing, on which are found those 
physical or biological features (PBF) essential to conservation of the species and which may 
require special management considerations or protection; and specific areas outside the 
geographical area occupied by the species if the agency determines that such area is essential for 
conservation of the species (16 USC § 1532(5).”) Four PBFs that support successful 
reproduction and recruitment were identified for the Atlantic sturgeon. Here, we consider the 
effects on PBF 1 and PBF 2. 

● PBF 1: Hard bottom substrate (e.g., rock, cobble, gravel, limestone, boulder, 
etc.) with salinity of 0.0 to 0.5 parts per thousand (ppt) (50 CFR 226.225 (a)(1)). 
PBF 1 habitat is utilized for spawning, fertilized egg deposit, refuge, growth, 
and development of early life stages. 
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● PBF 2: Aquatic habitat between the river mouth and spawning sites with soft 
substrate (e.g., mud, sand) and salinity from 0.5 to 30 ppt (50 CFR 
226.225(a)(2)). This area is used for juvenile foraging and physiological 
development.  

 
Within the NYB DPS, four rivers, the Hudson, Delaware, Housatonic, and Connecticut Rivers, 
were designated as critical habitat for Atlantic sturgeon. This paper focuses on the Delaware 
River. In the Delaware River, critical habitat occurs from its mouth at Delaware Bay (~River 
Mile (RM) 48.5) upstream to Trenton, New Jersey (~RM 133). The action area is within the 
lower portion of critical habitat from RM 48.5 upstream to RM 73.5.  
 
In the Delaware River, the longitudinal salinity gradient is dynamic and subject to short- and 
long-term changes caused by variations in freshwater inflows, tides, storm surge, weather (wind) 
conditions, etc. Specific salinity values or ranges may move upstream or downstream by as much 
as 10 miles over a day due to semi-diurnal tides and by more than 20 miles over periods ranging 
from a day to weeks or months due to storm and seasonal effects on freshwater inflows (USACE 
2015a). Given the dynamic nature of salinity near the salt front2, the availability of data on 
salinity values of 0.25 ppt but not salinity values of 0.5 ppt, and the very small area where there 
would be a difference in salinity between 0.25 and 0.5 ppt, it is reasonable to use the furthest 
downstream extent of the median range of the location of the salt front (0.25 ppt) as a proxy for 
the downstream border of PBF 1 in the Delaware River. Therefore, we consider the area 
upstream of RM 67 to have salinity levels consistent with the requirements of PBF 1 and the area 
downstream of RM 67 to approximately RM 48.5 to contain PBF 2. 

 Analytical Framework 
To determine the geographic extent of the effects of habitat loss and degradation on PBFs 1 and 
2, we analyzed the data at two levels–on the PBF as a whole and on the PBF within the action 
area. Impacts were calculated based on (1) the river area of the PBF (i.e. bank to bank), (2) the 
area of hard (PBF 1) or soft (PBF 2) substrate, (3) and the area of mesohaline and oligohaline 
zones (for PBF 2 only) as these two salinities zones are representative of different salinity 
gradients within PBF 2. Finally, we subtracted existing impacts before calculating project-related 
impacts. The following parameters were used to calculate impacts: 

• Total area of the river (bank to bank, RM 48.5 to 67 RM) within critical habitat and 
salinity (>0.5 ppt. 

• Action area. 
• Soft substrate within the area above. 
• Oligohaline zone.  
• Mesohaline zone.  
• Area of existing impacts (e.g., maintained navigation channels, islands, existing dredged 

terminal berths and access channels). 
• Area to be dredged for the proposed project. 

 

                                                            
2 The salt front is defined as the seven-day average location of the 250 mg/L chloride concentration. 
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Thus, the area impacted by the proposed project was then calculated as (proposed dredging)/ 
(total area - existing impacts). For this case, we analyzed the existing impacts (e.g., the existing 
federal navigation channel, dredging of berths at other ports, artificial reefs, etc.) within the 
action area to calculate the area of unimpacted bottom habitat. The impacts (i.e. dredging of 
access channels and berths) are then subtracted from the remaining, unimpacted habitat (the 
proposed dredging will occur in areas not currently dredged) to calculate impacts to the PBF 
within the action area. 

1.3 Projects Analyzed 
The proposed action in a biological opinion is defined as the description of the project as a whole 
and its subcomponents or specific activities. This description assists in determining the full range 
and type of effects of the action on listed species and critical habitat. Project components and 
activities for the construction developments include: 

1. Construction of wharf and bulkhead with pile driving. 
2. Construction of berth, access channel, and turning basin with dredging activities. 
3. Vessel routes by vessels during construction and by container vessels during port 

operation. 

 Edgemoor Terminal 
The Edgemoor project is the proposed construction of a new terminal in Delaware along the 
Delaware River. The terminal will extend approximately 3,200 feet along the western Delaware 
River shoreline. The project includes initial dredging and future maintenance dredging of a berth 
and access channel. The area to be dredged is approximately 87 acres and extends from the shore 
to the western boundary of the federal navigation channel. 
 
The proposed dredging will result in the removal of 87 acres of benthic habitat including 
invertebrates and prey for sturgeon. Future scour by propeller jets and maintenance dredging will 
continue to disturb the riverbed and affect recolonization by invertebrates. Therefore, it is 
reasonable to assume that the proposed project will result in a permanent reduction of available 
prey within 87 acres of the Delaware River. 
 

 New Jersey Wind Port 
The New Jersey Wind Port (NJWP) project includes the construction of the port (access channel, 
turning basin, and berth), the operation of the port, and the implementation of a mitigation plan 
to compensate for dredging in a portion of the action area. The proposed port is located on the 
east bank of the Delaware River within the greater estuary at approximately 52 RM, within the 
areas we are considering to be PBF 2 habitat. 
 
The in-water dredge footprint for the proposed project, including the berthing area, turning basin, 
approach channel, and quay, encompasses 85 acres of habitat providing benthic invertebrates and 
prey for sturgeon. Future scour by propeller jets and maintenance dredging will continue to 
disturb the riverbed and negatively affect recolonization by invertebrates. Therefore, it is 
reasonable to assume that the proposed project will result in a permanent reduction of available 
prey within 85 acres of the Delaware River. The action area also includes a site to mitigate 
impacts to Essential Fish Habitat under the Magnuson-Stevens Fisheries Conservation and 
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Management Act (up to 120-acres). Within the 120-acre area, the placement of concrete habitat 
structures will permanently cover approximately one acre of bottom substrate. These structures 
are planned to provide mitigation. 

1.4 Proposed Actions 
 Potential Stressors 

Stressors result from project related activities and cause variations in intensity of physical, 
chemical and biological consequences (i.e., effects) that may affect listed species. Besides the 
project sites, the extent of stressors define the action area. Stressors for the NJWP include: 

• Resuspension of bottom sediment and turbidity plumes caused by, for instance, dredging 
activities. 

• Noise caused by, for instance, pile driving. 
• Habitat loss from, for instance, dredging of bottom sediment or impacts from propeller 

jets. 
• Entrapment in dredges. 
• Vessel strikes. 

1.5 Baseline Conditions 
Baseline conditions are the current conditions (i.e., before the proposed action is implemented) 
of the action area. The GIS analysis was used to identify the areas and prepare graphics that 
depict the baseline features listed below. The GIS analysis will also include development of 
graphics and layers that represent the project area. 

 Physical Characteristics 
• River channels (Delaware River, Christina River, and Brandywine Creek) 
• Islands 
• Critical habitat 
• Salinity in Delaware River and Delaware Bay 
• Presence of soft and hard substrate 

 Baseline Activities Impacting Habitat 
Potential examples are described in the parentheses.  

1. Shore development (disconnect river from flood habitat, increase turbidity). 
2. The regular maintenance dredging of the Philadelphia to Sea Federal Navigation 

Channel, Christina River Federal Navigation Channel, and existing berths and access 
channels (habitat alteration). 

3. Vessel anchorages (anchor scars, propeller jet scour). 
4. Vessel traffic (propeller jet scour from cargo, tugs, and other vessels). 
5. Artificial reef construction and maintenance (converting soft substrate to hard substrate). 

  



 

9 

1.6 Action Area 
The “action area” is defined as “all areas to be affected directly or indirectly by the Federal 
action and not merely the immediate area involved in the action” (50 CFR § 402.02). This means 
As such, the area to be analyzed not only includes the direct footprint of the proposed action but 
also areas affected by stressors that are a consequence of the proposed action. In this case, the 
action consists of the following activities that define the direct footprint of the action: 

• Dredging area (berth, access channel, turning basin, etc.). 
• New structures footprint (wharf, bulkhead, piers, dolphins, etc.). 
• Vessel traffic travel trajectories (project vessels and vessels during operation). 
• Compensatory mitigation (dam removal and Fox Point restoration). 

 
Stressors as a consequence of the project that defines the action area include: 

• Distance of turbidity plumes (during dredging, pile driving, propeller jet, dam removal 
and fish passage construction, etc.). 

• Distance of sound from pile driving. 
• Bottom substrate disturbance (propeller jet, scour). 
• Areas where vessels will travel. 

 

1.7 Steps to Incorporating GIS Data 
The process of adding a GIS analysis to a Section 7 consultation, after defining the questions you 
hope to answer with the analysis, can be broken down into four basic steps: 

1. Identify and Collect Data 
2. Clean-up Data 
3. Calculate Results 
4. Develop Graphics 

These GIS files are regarded approximate representations and are not an official record for the 
actual regulated area borders since GIS projection and topological functions can modify or 
generalize coordinates.
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CHAPTER 2  
2.1 Identify and Collect Data 
In any GIS project, the first step is to identify and collect the data. For the analysis, we started 
with available data, including existing ArcGIS layers GIS applications can incorporate varied 
data, including, but not limited to cartographic, photographic, digital or spreadsheets data. 

• Cartographic data is already in map form and may include such information as the 
location of rivers, roads, hills, habitat data, and valleys. Cartographic data may also 
include survey data and mapping information that can be directly entered into GIS 
software 

• Photographic interpretation is frequently a major part of GIS. Photo interpretation 
involves analyzing aerial photographs and assessing the features that appear. 

• Digital data can also be entered into GIS. An example of this kind of information is 
computer data collected by satellites that show sea surface temperature. 

• Remote sensing provides another tool that can be integrated into a GIS. Remote sensing 
includes imagery and other data collected from satellites, balloons, and drones. 

 

2.2 Getting Started 
Good data is at the heart of any successful GIS analysis. Therefore, the data incorporated into a 
project should be accurate and current, come from known sources, and include the appropriate 
metadata. In order to create an accurate GIS analysis, the most-suitable data sets for the study 
areas should be used. For the New Jersey Wind Port project GIS analysis, we started with several 
existing data sets for the Delaware River. These data sets were chosen to represent parameters 
for the environmental impact assessment. As described in above, Atlantic sturgeon rely on a 
specific salinity gradient for spawning and rearing habitat quality within the Delaware River. 
Sturgeon also require firm bottom substrates for effective spawning and feed on soft bottom 
substrate beds. Therefore, any action that alters salinity, water quality, or bottom habitat could 
adversely affect Atlantic sturgeon or its critical habitat. 
 
Data Sets used for the Edgemoor and NJWP projects included: 
 
Benthic substrate layer including salinity zones:  
Benthic Substrate Habitat Types, Delaware Bay (DNREC) 
https://erma.noaa.gov/admin/layer/1073 
 
River Channels (Delaware River, Christina River, and Brandywine Creek): 
Coastal Maintained Channels in U.S. Waters (USACE) 
https://erma.noaa.gov/admin/layer/17308 
 
Anchorage Areas:  
Anchorages 
File: AnchorageAres.gdb 
Northeast Data Portal: https://www.northeastoceandata.org/ 
 
Critical Habitat (NOAA) 

https://erma.noaa.gov/admin/layer/1073
https://erma.noaa.gov/admin/layer/17308
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Section 7 Habitat 
https://www.fisheries.noaa.gov/national/endangered-species-conservation/critical-habitat#critical-habitat-
designations,-maps,-and-gis-data 
 
Project Dredging Areas: 
Hope Creek (NJWP) project GIS layer 
File: NJWP_01142021.zip 
Provided by Robert Rech AKRF, Inc. 
 
Edgemoor project GIS layer 
Edgemoor Dredge Area 
File: EdgemoorDredgeArea.zip 
Provided by Jessica Fedetz Duffield Associates, LLC. 
 
Benthic Substrate: 
Benthic Substrate Habitat Types, Delaware Bay (DNREC) 
https://erma.noaa.gov/admin/layer/1073 
 
These data sets were chosen to represent parameters for the GIS analysis to support the 
subsequent effects analyses. Salinity gradients are an important feature of the river and Atlantic 
sturgeon are diadromous fish and rely on a specific salinity for spawning and rearing within the 
Delaware River. 
 
As discussed in Chapter 1, substrate is an important habitat resource for this species. Soft 
substrate supporting benthic invertebrates for foraging and firm cobble habitat for spawning are 
identified as PBFs for Critical Habitat and adverse effects impacting these features need to be 
analyzed. Determining the spatial extent of the stressors' impact to the feature is a key first step 
in the analysis. 

2.3 Finding Sources for Data 
There are many open source and public data sets available to use for a GIS analysis and 
unpublished layers can often be obtained from the author or researcher. 

 Public Sources for GIS Data 
ESRI Open Data Hub is a free GIS data treasure trove. It now holds over 250,000 open data 
sets from 5,000+ organizations throughout the world. 
Natural Earth Data grants access to important cultural and physical vector GIS datasets on a 
worldwide basis.  
USGS Earth Explorer is one of the largest free sources of data for satellite and aerial data. 
NASA’s Socioeconomic Data and Applications Center (SEDAC) shows human interactions 
with the environment. It contains demographic information such as age, education, and density, 
and has over 800 citations. Nighttime lights also contribute to the worldwide urban and local 
population estimates. 
Open Topography provides a portal to high spatial resolution topographic data and tools. In 
particular, it houses LiDAR Data. 
 

https://www.fisheries.noaa.gov/national/endangered-species-conservation/critical-habitat#critical-habitat-designations,-maps,-and-gis-data
https://www.fisheries.noaa.gov/national/endangered-species-conservation/critical-habitat#critical-habitat-designations,-maps,-and-gis-data
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United Nations Environment Programme (UNEP) is the authoritative source for UN data and 
holds more than 500 variables such as freshwater, climate and health.  
NASA’s Earth Observations (NEO) data ranges from aerosols, chlorophyll to sea surface 
temperature. All are free GIS data sets in JPEG, GeoTIFF, and Google Earth formats. 
Sentinel-2 is the highest resolution satellite imagery available to the public for free. Its interface 
is the Copernicus Open Access Hub. 
National Weather Service data are mostly available in shapefile and keyhole markup language 
(KML). Their GIS weather data has a large database of historical data (all the way back to 1950) 
with precipitation and weather/climate data. 
MADIS GIS weather data contains real-time and observational data from land surface 
(temperature, wind, relative humidity, precipitation) and radiosonde (weather balloons). 
PRISM Parameter-elevation Regressions on Independent Slopes Model (PRISM) is an 
acronym for parameter-elevation Regressions on Independent Slopes Model. This application 
makes use of point precipitation, temperature, and other climatic variables, as well as a digital 
elevation model. 
 
NOAA Data Portal examples like the Environmental Response Management Application 
(ERMA), an online mapping tool that includes sediment layers. In addition, many programs 
maintain a repository of shared datasets. We recommend checking with GIS or information 
technology departments on what may be available. 

2.4 Navigating ArcGIS  
The minimum software required to follow this GIS analysis is ArcGIS Pro version 2.7 or newer. 
 
To use GIS, the desktop application for ArcGIS. When first launching ArcGIS Pro, there will be 
two options for start-up, create a new project or open an existing one. When starting a project, 
the directory should be given a unique name. The project can be saved in the directory with the 
name specified or an existing directory. This is known as the working directory. After the new 
project opens, the mouse scroll or the plus and minus buttons on the top left will control zooming 
in and out of the map.  A specific location can be identified on the map interface by entering the 
latitude/longitude coordinate pair, address, city, or zip code into the search tool box. The map 
will then zoom to that location. The scale of the map interface is shown by the ruler on the lower 
left corner of the map.  
 
ArcGIS Pro can be used to browse, modify, analyze, and distribute GIS data quickly and 
efficiently. ArcGIS Pro is also web-connected. This means that projects can access information 
stored online just as readily as data stored locally and easily share data online or locally. 
 
Multiple views of the map interface can be included in an ArcGIS Pro project. The fundamental 
data and symbology are the same across numerous views of your map, but the angle or zoom 
may be different. As a result, certain features of the map become more visible. 
 
A variety of maps and map frames can also be included in your project. If you include multiple 
maps that use the same data, it might be beneficial to keep them all in the same project. Layers 
can also be viewed differently by toggling some layers on and off. This allows you to represent 
different sets of data simultaneously on the map. 
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To run a successful GIS analysis, you will need to know how to navigate the software’s basic 
features and functions. 

CHAPTER 3  
3.1 Clean Data 
The initial data and layers collected for the study area had to be extracted and cleaned in order to 
be used for the geospatial analysis. Within the software, a number of tools are provided for data 
examination and cleansing. The migration of low-quality parcel data, inaccurate parcel joining, 
and incorrect parcel input can result in topological errors and data corruptions. Several functions 
within the ArcGIS software were utilized to clean and extract the data before it could be used in 
the analysis. A common issue associated with GIS projects is the projected Coordinate Reference 
System or CRS of the project. ArcGIS usually will determine the data’s location in geographic 
space by using the CRS that is associated with the source dataset. When multiple data sources 
are in use for the same project, the CRS must be uniform across the entire GIS project. A CRS 
instructs mapping software on how to flatten or project the data within geographic space based 
on the designated CRS. There are two main parts that make up the CRS data and additional 
parameters that could be project specific. 
 
Datum: A representation of the earth's form. It specifies the beginning point (i.e., where is (0, 0)) 
and contains angular units (i.e., degrees) so the angles correspond to a significant location on the 
planet. Both WGS84 and NAD83 are widely used global datums. Datums can also be local, 
meaning they are appropriate for a certain region of the world but inappropriate elsewhere. In 
this workshop, the WGS84 datum will be employed. 
 
Angular Measurements: Measurements on a spherical earth are mathematically transformed to 
a flat surface by projection (i.e. paper or a computer screen). Typically, the units connected to a 
specific projection are linear (feet, meters, etc.). We will see data in two alternative projections 
throughout this course. 
 
Additional Parameters can be necessary to create the full coordinate reference system. One 
common additional parameter is a definition of the center of the map. The number of required 
additional parameters depends on what is needed by each specific projection. 

3.2 Upload Data to ArcGIS 
You can quickly and easily upload new data or edit features using ArcGIS Pro. There are three 
feature types: polygons, points, and lines. Polygons contain areal data, points contain point data, 
and lines contain linear data. The ArcGIS features available depend on the type of data uploaded 
to the project. The features below may not be available for certain GIS data types or analyses.  
Importing Data into the ArcGIS Project 
 

1. In the Maps tab, click “Add Data” and select “Import File”. The Import File pane 
appears. 

2. Click “Browse” and select the file that contains the data you want to import. Usually, this 
data is a raster, shapefile, excel file, or point file. Once selected, the file name appears in 
the Selected text box. 

3. Click “Ok”. 
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4. Edit the layer name in the new layer name text box in the pane on the left side of the map. 
You can edit the layer’s name by double-clicking or right-click and selecting “Rename” 
from the pop-up window. 

5. Check the Open all labels for imported data check box to label each of the sites. When 
you are finished, click “Next”. 

6. Change the Border and Fill properties for the layer. Click “Save” when you are finished. 
7. Your data should appear as a new layer in the current project. 

 

 
Figure 3-1. Importing Data into ArcGIS. 



 

15 

 
Figure 3-2. Selecting Data to Load to the ArcGIS Project. 

3.3 Editing/Creating New Layers for Existing Datasets 
After data has been uploaded to ArcGIS, it may need editing before it can be used for analysis. In 
the NJWP GIS analysis we first created new layers from the benthic substrate data. As the data 
sets collected were larger than the study area, we then used the “Edit Features” function for this 
project to clip the new polygons to fit the NJWP Consultation’s study area (see Clip Polygons 
3.4 and Merge Polygons 3.5).  
 
Creating a New Layer from Selecting Attributes 
 

1. Open “Attribute Table” for the layer by locating it within the layer settings. 
2. At the top of the Attribute Table, click the “Select by Attributes” button. 
3. Create a “New Selection” and choose the attribute within the data to sort by. Then click 

“Apply”.  For the substrate layer, several query functions were used to create a layer from 
the soft substrate and hard substrate types. This was done by creating two different 
expressions, one that selected only the soft substrate one that selected only the hard 
substrate polygons within the benthic substrate dataset. 

4. In the bottom left corner of the attribute table, click “Show Selected Records”. This 
displays only the selected data from the previously selected attributes. 

In the project panel, click the “Data” tab and click “Export Features”. This creates a new layer 
from the selected data while keeping the original data intact. 
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Figure 3-3. Opening Attribute Table. 

 
Figure 3-4. Selecting by Attributes. 
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Figure 3-5. Sort by Expression. 

 
Figure 3-6. Show Selected Data. 
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Figure 3-7. Creating a New Layer from Selected Data.
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3.4 Merge Polygons 
The substrate layer used for the GIS analysis in the Delaware River contained 9,144 individual 
polygons. Without merging and clipping the original dataset, it would be too large to use, and the 
detailed information (polygons) on individual substrate types was not needed for this project. To 
condense the data into usable information, the dataset was divided and categorized into hard 
substrate (e.g., shell, bedrock, gravel) and soft substrate (e.g., sand, silt, clay). This provided a 
copy of the original dataset categorized into hard and soft substrates that could be merged into a 
single polygon for each category (one layer for the hard substrate area, one layer for the soft 
substrate area). These two datasets still contained many overlapping polygons for different hard 
and soft substrate types.  
 
The overlapping polygons from the substrate were merged together and a second clip was 
performed to fit the action area for the consultation. This resulted in two distinct layers for the 
Delaware River. One layer for hard substrate and one layer for soft substrate. This is an 
important step that condenses the polygons into a single feature. A second clip was used to create 
an additional layer with the substrate data for the action area. This will remove any overlapping 
polygons and make the data usable for the analysis. 
 

 Steps to Merging Polygon Datasets in ArcGIS 
 

1. In the Edit Tab, click the “Merge” function located within the “tools” section. 
2. Open the Attributes Table to view the polygons within the layers. 
3. Select all polygons within the layer that will be merged. Note that polygons must be 

located within the same layer to be merged or clipped. 
4. When the Merge Window updates with the selected polygon features, click “Merge”. 

This will merge all the selected polygons into a single polygon. 
5. After the merge, the Attribute Table should show the single merged polygon. 
6. In the “Edit” tab click “Save” in the “Manage Edits” section to save all edits.  
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Figure 3-8. Attribute Table Polygon View. 

 
Figure 3-9. Selecting Polygon Features to Merge. 
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Figure 3-10. Selecting Polygon Features to Merge. 

 
Figure 3-11. Merging the Polygons within the Layer. 
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Figure 3-12. Attribute Table After a Successful Merge. 

 

 
Figure 3-13. Saving the Edits to the Layer. 
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3.5 Clip Polygons 
In the NJWP analysis, most data layers were clipped from the original datasets to provide 
information for the GIS analysis in the Delaware River. Some functions in GIS, like clipping 
polygon layers, can be time consuming and dependent on dataset size.  
 

 Steps to Merge then Clip Polygon Datasets in ArcGIS 
1. Import additional data layers to clip.  
2. In the “Edit” Tab, click the “Merge” function located within the tools section. 
3. Merge all the polygons in the dataset into a single polygon. The “Anchorages” layer 

needed to be merged into a single polygon before it could be used to clip additional 
project layers. The merging process simplifies the clipping process. 

4. In the “Edit” tab, “Save” all edits. 
5. In the “Analysis” tab, click the “Merge” function in the tools section. This function will 

merge selected features in separate layers to a single layer. 
6. Select the layers you wish to merge and click “Merge”. 
7. In the “Edit” tab click “Clip” in the tools section. 
8. Select the polygons you wish to clip and click “Clip”. It is easier to open the attribute 

table for the layer and select the polygons from the table. 
9. The finished layer will appear on the left in the Contents pane (please see ArcGIS Pro 

documentation for more information about opening the Contents pane). In the “Edit” tab, 
“Save” all edits. 

 

 
Figure 3-14. Importing Additional Layers. 
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Figure 3-15. Selecting New Data. 

 
Figure 3-16. Merge Polygons. 
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Figure 3-17. Save Edits. 

 
Figure 3-18. Merging Features from Separate Layers. 
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Figure 3-19. Selecting Layers to Merge. 

 
Figure 3-20. Clipping Polygons in the Same Layer. 
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Figure 3-21. Select Polygons and Save Edits.
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CHAPTER 4  
4.1 Calculate Results 
After clipping each layer to fit the geographic location of the consultation, the area was computed 
using ArcGIS toolbox functions. For these calculations, we utilized the “calculate geometry 
attributes'' tool. This tool uses the geographic coordination system to calculate the area of a 
polygon layer within the mapping software. The tool adds information to a feature or layer’s 
attribute field representing the spatial or geometry characteristics and location of each feature, 
such as length or area and x-, y-, z - coordinates. This tool is useful because it can convert the 
area into any desired unit. 

 Calculating Geodesic Area of a Polygon 
1. Open the Attribute Table of the Layer and under the “Data” tab click “Fields” in 

the design section. This opens a window that will let you add or delete data 
attributes for the layer. 

2. Scroll to the bottom of the Fields Table and click the bottom row to add a new 
field. 

3. Name the new attribute and change attribute settings. Since we will be using this 
field to calculate the area the “Data Type” will be “Long” and the “Number 
Format” will be “Numeric”. The data field name created for the hard substrate 
layer was called “Area_Acres”. 

4. When the Numeric window pops up, view the number display settings and adjust 
if necessary. 

5. In the “Analysis” tab click the toolbox in the Geoprocessing section. 
6. When the Geoprocessing pane opens on the left, search for “Calculate Geometry 

Attributes” and click the function. 
7. In the “Calculate Geometry Attributes” pane, select the layer you would like to 

calculate the area for.  “Target attribute” is the field created in the previous steps 
or “data field” where the geometry attributes will be calculated (e.g., 
“Area_Acres”).  

8. “Property” is the calculation function. The NJWP analysis utilized the “Area 
(geodesic)” function. 

9. “Area Unit” is the unit that the calculation will be produced in. The NJWP 
analysis produced results in the unit of Acres. 

10. “Coordinate System” will be used to determine coordinates, length, and area. By 
default, the input features’ coordinate system is utilized. 

11. After the parameters are set, click “Run”.  
12. The finished calculation for area is displayed in the data field you created, in this 

case the field“Area_Acres”. 
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Figure 4-1. Finding the Fields Table. 

 
Figure 4-2. Adding a New Attribute Field. 
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Figure 4-3. New Attribute Set-Up. 

 
Figure 4-4. Numeric Format Settings. 
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Figure 4-5. Select the Geoprocessing Toolbox. 

 
Figure 4-6. Using the “Calculate Geometry Attributes” Tool. 
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Figure 4-7. Geometry Attributes Parameters. 

 
Figure 4-8. Running the Calculations. 
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Figure 4-9. Finished Calculations Displayed in the Attribute Table.
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CHAPTER 5  
5.1 Illustrating Layouts 
A page layout in ArcGIS is a collection of map components that are grouped on a page for 
map printing. Each layout can contain one or more map frames that depict the data and 
layers in the ArcGIS project. These layouts are a useful tool to develop research figures. A 
layout page can incorporate several components; an ordered collection of map layers, a scale 
bar, a graticule, north arrow, a map title, descriptive text, and a legend. 

 Map Frames 

Map frames, which can refer to any map or scene in the project or no map at all, are used to 
add maps to layouts. Scene layers are used to visualize 3D material. Layout files can be 
utilized as templates, when the same layout will be used in several projects, a map frame 
without a map is beneficial.  Map frames can only be edited when in the activation mode. 
You can put a map frame in activation mode by right-clicking the map frame in the Contents 
window and selecting “Activate”. When a map frame is activated, you can adjust the 
visibility of layers, map extent, and symbology. The map that a map frame links to can be 
modified at any time after it has been created by reactivating the map frame. 
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5.2 Creating a Layout 
Layouts can be customized to fit any project and display multiple maps and layers for a 
project. Elements in a layout can be chosen, moved, and scaled once they have been added 
to the layout to obtain the desired style and feel. To create a blank layout, insert a new 
layout file from the Import Layout gallery, or import a layout file to add a layout to a 
project. The steps below describe how to create a map from a blank layout file in ArcGIS.  

 Illustrating a Map from a Blank Layout File in ArcGIS 
1. Within the Insert Tab click “New Layout”. Here, you can choose the desired paper 

size. A new layout tab will open next to the map tab in the mapping window.  
2. Select “Map Frame” in the Insert tab and choose the map source for the layout. 

Then, drag the box on the page to resize and place the map.  
3. The map layers should appear in the contents window on the left, and the map 

should be visible. You can change what layers are displayed on the map by checking 
and unchecking the boxes next to the layer names.  

4. To activate the map frame, right-click the map in the contents pane and select 
“Activate.” 

5. To adjust a layer’s symbology, under the “Feature Layer” window, in the 
“Appearance” tab, click symbology. The symbology editing pane will open on the 
right. Here, the appearance of the layer can be customized. The symbology can also 
be changed in the map frame, which is useful for looking at the data even if a layout 
isn’t used. 

6. In the symbology window, you can change the symbol, label, colors, and description 
of the layer. The transparency of the layer was adjusted to fifty percent. The symbol 
for the Delaware River area was changed to 10% crosshatch by clicking the drop 
down box next to “Symbol” in the symbology window. 

7. Under the Map Frame window, click “Format” and close the map activation. 
8. Text boxes can also be added to the layout. Under the “Insert” tab, in the “Graphics 

and Text” section, click the “Straight Text” box. 
9. Drag the text box to size to create a title. The title for this layout is “Delaware River 

Area.” 
10. To add a legend, go to the “Insert” tab, in the “Map Surrounds” section, and click the 

“Legend” icon. Layer names can be edited in the layer’s properties to be reflective in 
the legend. 

11. Drag the legend to size under the map frame. The activated layers should 
automatically populate in the legend.  

12. Repeat the previous steps to add the north arrow and scale bar. 
13. The scale bar should be in the same units as the results you want to depict. For this 

example, the example displays the scale in miles. This project used river miles as 
units, and nautical miles were not used as units. 

14. You may examine and alter the properties of a layout at any time after it has been 
created. To do so, open the “Layout Properties” window by right-clicking the layout 
name in the Contents pane and selecting “Properties”. 

15. After the layout is completed, you can export the completed map at a high resolution 
to share. You can also export to programs such as excel for further analysis. Under 
the “Share” tab, in the export section, click “Layout”.  
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16. When the export window opens on the left, you can adjust the export properties. 
Click “Export” to save and share the layout as an image.  
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Figure 5-1. Creating a Layout and Map. 

 
Figure 5-2. Select Map Frame. 
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Figure 5-3. Changing Layers Visible in the Layout. 

 
Figure 5-4. Activating the Map Frame. 
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Figure 5-5. Activating the Map Frame. 

 
Figure 5-6. Changing the Symbology. 
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Figure 5-7. The Symbology Window. 

 
Figure 5-8. Adjusting Layer Transparency. 
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Figure 5-9. Changing the Layer Display Pattern. 

 
Figure 5-10. Close the Map Activation. 
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Figure 5-11. Adding Text to a Layout. 

 
Figure 5-12. Create a Title for the Layout. 
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Figure 5-13. Adding a Legend to the Layout. 
 

 
Figure 5-14. Place the Legend on the Layout. 
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Figure 5-15. Inserting a North Arrow. 
 

 
Figure 5-16. Inserting a Scale Bar into the Layout. 
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Figure 5-17. Finding the Layout Properties. 
 

 
Figure 5-18. Exporting the Layout. 
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Figure 5-19. Export Setting for Maps.
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CHAPTER 6  
6.1 GIS Analysis Results 
The table below shows all of the project layers and their designated calculations from the GIS 
analysis. The geographical range and location of each layer is defined in River Miles along the 
Delaware River.  
 
Table 6-1. Results of geodesic area calculations from ArcGIS. 

Calculation Layer Name 
Value Area 
(Acres) Map Image 

Location (River 
Miles) Description 

Edgemoor 
Project Area Action Area 1 935.5 ActionArea1.jpg 

RM 73.5- RM 
48.5 

Area from the shore  
to the East part of the 
Philadelphia to the 
Sea Navigation 
Channel 

Action Area 2 
Action Area 
Polygon 2 2784.45 PilotActionArea.jpg 

RM 73.5- RM 
48.5 

All navigation areas, 
Christina River 
Mouth, and Pilot 
Area. 

Delaware River 
downstream of 
Little Tinicum 
Island 

Action Area 
Polygon 3 49340.88 ActionArea3.jpg RM 48.5 - RM 86 

Total river area, bank 
to bank, of the 
Delaware River 
downstream of Little 
Tinicum Island to the 
mouth of the River 

PBF 2 Salinity 
Area 
(mesohaline) Salinityzone 28487.21 

SalinityzoneRM48-
RM67.jpg RM 48.5 - RM 67 

Extent of PBF2 
overlapping with the 
mesohaline zone. 

PBF 2 Salinity 
Action Area 

Salinity_PBF2_Are
a_Dredged 0  RM 48.5 - RM 67 

Area of mesohaline in 
action area 

PBF 2 
Oligohaline 

Oligohaline_AreaR
M58-RM67 12774.74 

Oligohaline_RM58-
RM67.jpg RM 58- RM 67 

Area of the 
oligohaline zone 
overlapping with PBF 
2 

PBF 2 
Oligohaline 
Action Area 

Oligohaline_PBF2_
Area_Dredged 0  RM 58- RM 67 

Area oligohaline in 
action area 

Rearing Habitat 
(bank to bank) 

RearingHabitat_Act
ion_Area 17665.13 

Rearing_Habitat_RM6
7-RM86 RM 67- RM 86 

Total freshwater 
rearing habitat 

Rearing habitat 
(soft substrate) 

RearingHabitat_Soft
Substrate 8752.77 

RearingHabitat_SoftSu
bstrate_RM67-RM86 RM 67- RM 86 

Area of soft substrate 
in rearing habitat 

Rearing Habitat 
in Action Area 

RearingHabitat_Act
ion_Area_Clip 86.58 

RearingHabitat_Dredg
ed.jpg RM 67- RM 86 

Area of rearing 
habitat in action area 

Soft Substrate 
Dredged from 
Rearing Habitat 

RearingSoftSubstrat
e_Dredged_Clip 64.55 

RearingSoftSubstrate_
Dredged RM 67- RM 86 

Area of soft substrate 
in action area 
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PBF2 area PBF2_Total_Area 30768.23 
PBF2_Total_Area_RM
48-RM67 RM 48.5- RM 67 Total PBF2 area 

PBF 2 (Soft 
Substrate) Soft_substrate_total 23016.25 

PBF2_Soft_Substrate_
Total_RM48-RM67 RM 48.5- RM 67 

Total soft substrate 
area 

PBF 2 (Soft 
Substrate 
Action Area) 

PBF2_Softsub_Acti
onArea 21692.15 

PBF2_Soft_Substrate_
RM48-RM67 RM 48.5- RM 67 

Area of soft substrate 
not affected by 
navigation channel 

PBF 1 total area 
RearingHabitat_Act
ion_Area 17665.13 

Rearing_Habitat_RM6
7-RM86 RM 67- RM 86 

Total area of rearing 
habitat in action area 

PBF 1 
Freshwater area 
and hard 
substrate 

PBF1_Hard_Substra
te 4337.1 Hard_Substrate_PBF1 RM 67- RM 86 

Total area of PBF1 
habitat 

NJWP PBF 2 
Hope_Creek_PBF2
_Total 9945.33 

Hope_Terminal_PBF2
_RM48-RM53 RM 48.5- RM 53 NJWP action area 

NJWP Soft 
Substrate total 

Soft_substrate_total
_Merge 6246.13 

Hope_Terminal_Soft_
Substrate_RM48-
RM53 RM 48.5- RM 53 

Total PBF2 area not 
affected by 
navigation channel 

NJWP Action 
areas 

PBF2_Soft_Substrat
e_total_HopeCreekl
Final 6208.31 

HopeTerminalPBF2_S
oft_Substrate_Total_R
M48-RM53.jpg RM 48.5- RM 53 

Area of PBF2 within 
NJWP action area 
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6.2 Incorporate Results 
ArcGIS was used to support the development of the biological opinions for two projects: the 
proposed construction of the Edgemoor Terminal in Delaware and the proposed 
construction of the New Jersey Wind Port in New Jersey (NJWP) also known as the “Hope 
Creek Port” BiOp.). This project demonstrated that the analysis in biological opinions 
benefit from using geo-spatial data and GIS software (ESRI ArcGIS in this case) by 
providing quantitative results and graphical representation of action area, PBFs, and other 
features included in the effects analysis. For federal actions used in this project, we focused 
on calculating the action area for the Edgemoor Terminal while analyzing geographic extent 
of activities impacting critical habitat (foraging habitat supporting acclimation to 
increasingly saline waters (PBF 2)) for the NJWP. In the biological opinion, NOAA 
Fisheries first calculated impacts to habitat and effects to species within the action areas, 
e.g., as shown in Figure 6-1 and Figure 6-2. Here, we show how the results of our GIS 
analysis were used to calculate the area of the Edgemoor Terminal project within the lower 
Delaware River estuary. We also show how GIS calculations of PBF 2 are used to analyze 
dredging for the NJWP. 

 Edgemoor Terminal 
For the Edgemoor Terminal, we used ArcGIS to delineate the portion of the action area that 
is defined by construction activities and the associated stressors (Figure 6-1). Note that the 
action area also includes vessel traffic from the mouth of the Delaware River to the mouth 
of the Delaware Bay during operation of the terminal; this is not included in the calculations 
for this GIS project. Stressors from the project include: (1) dredging and associated 
turbidity, (2) sound from pile driving; (3) vessel (i.e., tug) traffic in the channel from 
Wilmington Port to the construction site and dredge disposal areas; (4) and vessel traffic at a 
compensatory mitigation site at Fox Point, which is just upstream of the port site. This 
project lies within the predicted PBF 1 habitat present in the Delaware River from RM 67 - 
RM 133.  

 Calculations for Edgemoor Terminal 
 
Table 6-2. Calculations for the Edgemoor Project. 

Calculation Type Area (Acres) Location (River Miles) Description 

Rearing Habitat (bank to bank) 17665.13 RM 67- RM 86 Total rearing habitat 

Rearing habitat (soft substrate) 8752.77 RM 67- RM 86 Area of soft substrate in rearing habitat 

Rearing Habitat in Action Area 86.58 RM 67- RM 86 Area of rearing habitat in dredging area 

Soft Substrate Dredged from Rearing Habitat 64.55 RM 67- RM 86 Area of soft substrate in dredging area 

PBF 1 total area 17665.13 RM 67- RM 86 Total area of rearing habitat in action area 

PBF 1 Freshwater area and hard substrate 4337.1 RM 67- RM 86 Total area of PBF1 habitat 
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Figure 6-1. Project Area for Edgemoor Terminal Project. 

 
Figure 6-2. Habitat Area (solid shading) Impacted by Proposed Dredging for Edgemoor Terminal 

Deriving these graphics based on existing datasets for the study is an important ability tool 
that helps quantify action areas and present it graphically. Figure 6-2 depicts the habitat area 
that will be impacted by the proposed dredging for the Edgemoor Terminal Project. Visual 
graphics can also allow officials to understand the baseline conditions (current existing 
habitat conditions like salinity boundaries and substrate patch type) for the study area before 
the proposed construction or project. Baseline activities are all activities that affect the 
environment and species within the action area and knowing their geographic extent is a 
very useful measure to assist with the subsequent environmental analysis. 
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 New Jersey Wind Port 
Quantifying the geographic extent of environmental impacts for the NJWP provided the 
background information and evidence to show that this project may adversely affect the 
habitat for Atlantic sturgeon within the Delaware River. Using GIS software to cross-
reference the location of key resources for Atlantic sturgeon (e.g., soft substrate within 
critical habitat where salinity is 0.5 to 30 ppt, i.e. PBF 1) with current habitat disruptions 
(e.g. navigation channel, anchorage areas) and proposed habitat disruptions 
(proposed/maintenance dredging), we were able to calculate the area of resource and habitat 
loss within the Delaware River. This allows for a more accurate and thorough description of 
how the proposed NJWP will affect Atlantic sturgeon habitat.  
 
For this project, the action area overlapping PBF 2 was determined by construction 
activities, projected vessel traffic during construction and operation of the NJWP, 
construction at a mitigation site, and stressors associated with these activities. First, we 
defined and quantified the acreage of the action area. The action area, which included the 
530-acre project area, the 120-acre mitigation site, and other areas impacted by the project 
activities, was roughly 2,604 acres in total (Table 6-3). During the Port's operation, boats 
will sail between the Pilot Area at the Delaware Bay's mouth and the Port. 
 
Within this area, approximately 85 acres will be impacted by construction dredging, 
mitigation dredging, and continuous impacts from vessel traffic. This area was defined 
previously within the dredging footprint of the NJWP. Because of the continued disturbance 
to soft substrate within the access channel, turning basin, and berth, these impacts are 
considered long-term. In addition, approximately one acre will be permanently converted 
from soft substrate to hard substrate to mitigate for loss of essential fish habitat under the 
Magnuson-Stevens Fishery Conservation and Management Act. Thus, assuming all 
impacted areas consist of soft substrate, the proposed project will impact approximately 86 
acres of PBF 2. 
 
Table 6-3. Acreage of the New Jersey Wind Port Action Area within PBF 2 and acreage of long-term 
habitat impacts to PBF 2. Acreages are from the biological assessment provided by the USACE. 

Activity Overall Acreage Habitat Conversion 

Project Area 530  

         Dredging footprint  85 

Vessel Traffic (navigation channel) 1,954  

Mitigation Site 120  

       Conversion of soft to hard substrate  1 

All 2,604 86 

 
For the NJWP, the final impacts in terms of the proposed action in the biological opinion 
was “may adversely affect but not likely to adversely modify or destroy critical habitat 
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designated for the New York Bight DPS of Atlantic sturgeon” (NMFS 2022). Now, we look 
at the GIS results that impacted this decision. 
 
In this section, the results from the NJWP analysis will be shown to demonstrate how the 
findings assisted in making this determination. The results below are sample values that 
assisted the biological opinion.  
 
This GIS analysis was used to predict where PBF2 habitat is present within the Delaware 
River and to estimate the portion of this habitat that could be impacted by the proposed 
NJWP. These calculations were completed using subsets of the layers described in Chapter 
2. All layers used and subsets derived from these layers are listed in Table 6-1. These 
calculations may also be useful in future biological opinions (see Chapter 7.) 
 

 
Figure 6-3. Action Area within critical habitat with salinity ≥ 0.5 ppt (RM 48.5 to RM 67). The action area 
also includes the federal navigation channel (not shown here). 

 
The data subsets were compiled by following a series of merging and clipping techniques to 
display the study area. Then, the layers were split by the estimated salinity boundary to 
predict the total possible reach of PBF1 and PBF2 habitat within the Delaware River. These 
results are listed under the layer “RearingHabitat_Action_Area” shown in Table 6-1. 
Rearing habitat calculations are used to assess direct impacts to Atlantic sturgeon critical 
habitat within the action area. 
 
After determining the extent of PBF1 and PBF2 habitat, the “Benthic Substrate Habitat 
Types, Delaware Bay (DNREC)” layer was used to predict where areas of hard and soft 
substrate exist within PBF1 (freshwater and hard substrate) and PBF2 (salinity greater than 
0.5 ppt and soft substrate) habitat areas for the reach of the Delaware River considered here. 
The final predicted areas of PBF1 and PBF2 reach in the Delaware River are depicted below 
in Figure 6-4 and Figure 6-5. Overlaying the layers for dredging with the layers of PBF1 
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and PBF2 showed that the construction of the proposed Edgemoor Terminal will not affect 
PBF 1 (no hard substrate within the dredged area) or PBF 2 (the terminal is located 
upstream of PBF 2) while the NJWP will affect PBF 2.  
 
Subset Data Layers Used to Estimate Salinity Boundaries (Calculated within GIS)  
 
• Salinityzone 
• Salinity_PBF2_Area_Dredged 
• Oligohaline_AreaRM58-RM67 
• Oligohaline_PBF2_Area_Dredged 
 
Subset Data Layers Used to Estimate Patches of Hard Substrate and Soft Substrate 
(Calculated within GIS) 
 
• RearingHabitat_Action_Area 
• RearingHabitat_SoftSubstrate 
• RearingHabitat_Action_Area_Clip 
• RearingSoftSubstrate_Dredged_Clip 
• PBF2_Total_Area 
• Soft_substrate_total 
• PBF2_Softsub_ActionArea 
• RearingHabitat_Action_Area 
• PBF1_Hard_Substrate 
 
GIS can be used to assess and quantify the geographic extent of environmental impacts. By 
utilizing GIS software to georeference the NJWP project area, habitat areas with significant 
dredging can be located and the extent of impacts can be quantified. In analyzing impacts to 
foraging habitat and PBF 2, the total area of PBF 2 within the action area and the area 
impacted is used to calculate percent of impacts. 
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Figure 6-4. Map of the PBF1 Habitat within the Delaware River. 

 

 
Figure 6-5. Map of the PBF2 Habitat within the Delaware River 
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6.3 Calculating the Action Area for the NJWP 
Table 6-4. New Jersey Wind Port Calculations. 

Calculation Type Area (Acres) Location (River Miles) Description 

NJWP PBF 2 9945.3275 RM 48- RM 53 NJWP action area 

NJWP Soft Substrate total 6246.126 RM 48- RM 53 
Total PBF2 area not affected 
by navigation channel 

NJWP Action areas 6208.3099 RM 48- RM 53 
Area of PBF2 within NJWP 
action area 

 
The action area for the New Jersey Wind Port was calculated within the critical habitat of 
the Delaware River to be 6,208.3 acres. The action area includes the 85-acre dredge 
footprint and one acre of habitat conversion from soft to hard substrate for the compensatory 
mitigation. Figure 6-6 depicts the PBF 2 habitat within the Delaware River, NJWP Project 
Area and the area of the Navigation Channel from RM 48.5 to RM 67. 
 

 
Figure 6-6. PBF 2 Habitat Area with the NJWP Action Area and Navigation Channel RM 48.5 to RM 
67. 
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Figure 6-7. Soft Substrate Area with NJWP Action Area and Navigation Channel RM 48.5 to RM 67. 

The 2017 report by the Partnership for the Delaware Estuary was used in the analysis to 
calculate the area of the oligohaline (relative lower salinity) and mesohaline (relative higher 
salinity) zones, which reflects the gradient between them. The overlap between soft 
substrate areas and the mesohaline portion of PBF2 within the Critical Habitat of the 
Delaware River and the action area was then determined. Since sturgeon move up the 
salinity gradient (i.e., downstream) as they mature and get larger, they require incremental 
levels of salinity to acclimate. As such, predicting where the action area lies within the PBF 
habitat along the salinity gradient will both estimate what life stages of Atlantic sturgeon 
could be impacted by the action and its impacts on critical habitat PBF 2. In this case, the 
higher salinity portion of PBF 2 as well as older juvenile sturgeon were expected to be 
impacted.  
 
To recap, the area of mesohaline and soft substrate patches that intersect from RM 48.5 to 
RM 53 were quantified using the “Merge”, “Clip”, and “Calculate Geodesic Area” tools in 
ArcGIS to understand the total predicted impact of this construction on critical habitat for 
Atlantic sturgeon. The NJWP action area layer used to quantify how much of the predicted 
PBF2 habitat would be impacted by the proposed NJWP. Calculating the proposed project 
impact area for the NJWP (action area) that lies within the PBF2 habitat can estimate the 
area and percent of habitat that may be adversely affected or modified. 
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CHAPTER 7  
7.1 Benefits and Limitations of Incorporating a GIS Analysis into a 

Federal Consultation 
There are several direct benefits of using GIS to analyze environmental impacts, such as, 
transparency to stakeholders, quantitative results, clear metadata, and creating a replicable 
process. Utilizing GIS can provide a more detailed understanding of impacts to ecosystems 
from proposed projects and allow stakeholders to make more well-informed decisions about 
projects that may have a large impact on their surrounding environment. 
 
Further, GIS analyses can provide quantification of geographic or areal extents of certain 
activities. They can also provide graphic representation of changes in temporal distributions.  
These outputs are also information, which should be accompanied by complete metadata 
ensuring that data are easy to find, use, preserve, and re-use. Another benefit of using 
quantitative data is that it relies on metrics that can help to remove biases from the research 
and make findings more accurate and replicable. However, there is always some subjectivity 
about how lines and areas are drawn. 
 
There are also several indirect benefits to incorporating a GIS analysis into a federal 
consultation. GIS software is easy to learn and use and can keep record of cumulative 
impacts over time. GIS analyses can also uncover high-risk environmental areas and be 
reused to solve problems or support additional consultations. Further, this process can be 
used to inform whether specific regulatory goals (e.g., impacting no more than 5% of the 
rearing habitat within the next year) are achievable. Online tools and data portals can 
provide a good stepping-stone to understand the data layers, the information and extent 
provided in them, and the issues surrounding each project.  
 
The Delaware River is a study area that is rich in geospatial data and has an abundance of 
open source datasets which makes it more accessible to complete a GIS analysis than other 
Rivers. However, accessibility to sturgeon-specific datasets is a limitation. Access to data, 
having available data, and the quality of the data will affect the accuracy of the GIS 
analysis. Although GIS analyses can provide numerous benefits to federal consultations, 
some limitations exist as described below. 
 
Common Limitations in GIS  
 
Type of Data 
The analysis that can be conducted is limited by the type of data (e.g. point, polygons, or 
lines) available. 
 
Study Area 
The research area of analysis is determined by the action area and is often a limitation in a 
GIS analysis. The study area limits the data available for analysis. If the study area is too 
small or too large, visualizing significant changes from the data may be difficult.  
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Lack of Available Data 
A lack of data, particularly accurate data, will restrict the scope of research and sample size, 
or it will be a substantial impediment to discovering a trend and a meaningful link between 
geospatial data and environmental impacts. If the sample size is too small, finding 
significant relationships from the data will be difficult, as statistical tests typically require a 
larger sample size to ensure a representative distribution of the population. 
 
Lack of Prior Research 
Citing previous research studies is usually the cornerstone of a literature evaluation, but GIS 
analyses are not as popular as other methods of research for environmental data. This could 
potentially lead to a lack of prior GIS research in a variety of environmental areas of focus. 
For example, Atlantic sturgeon have a lack of extensive geospatial data and previous 
geospatial research.   
 
Data Quality 
Available data does not indicate high-quality data. Many datasets are subject to their own 
limitations and biases. Data quality is another cornerstone of any GIS installation and 
application, as trustworthy data is required for the user to receive useful results. 

7.2 Data Gaps 
The UN Environment Programme (UNEP) examined the framework of Sustainable 
Development Goal indicators in March 2019, but could only formally examine the status of 
30 environmental indicators at the worldwide level owing to a lack of data (Christensen, and 
Olhoff, 2019). This framework is an example of limitations in existing data. The use of GIS 
can help identify and locate existing gaps in data. Some limitations uncovered for the 
Delaware River within the GIS analysis include current data, such as outdated records of 
salinity, substrate and sturgeon distribution. This can help lead to better funding allocation 
and research projects that increase data availability.  
 
As we move into the future, it is important for these datasets to be accessible and maintained 
so that researchers can continue to use them in quantitative analyses. With future 
innovations in remote sensing, big data, and artificial intelligence, there will likely be more 
scenarios in which GIS analyses can be used to assist biological opinions. For that reason, 
we suggest investigating this topic more in the future. 

CONCLUSION 
This document provides guidance for the use of GIS analyses in biological opinions. GIS 
analyses can be used to summarize, quantify, compare, and visualize the geographic extents 
of baseline habitats and action areas to assist future analysis of impacts for the ESA Section 
7 federal consultation process. Incorporating geographical analyses can improve the 
consultation process by understanding overlaps, minimizing conflicts, quantifying impacts, 
and increasing transparency for stakeholders within the federal process. There are 
limitations based on lack of data and staff resources. However, online tools such as ERMA 
or NOAA’s Geoplatform make data more accessible for GIS analyses Despite the 
limitations, incorporating a GIS analysis into a federal consultation can lead to a more 
informed decision making process.  
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